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Overview

Introduction of CellDesigner
What kind of model you can build

How to build a model with CellDesigner
From scratch
Import a model, kinetic law and 
parameters from existing databases



Installation



Create model
Create new model:

[File] → [New] → input title → [OK]



Tips
Enable [Grid Snap] will help you draw 
your model much easier



Create Reaction
Create Protein “A” and “B”
Draw “State transition”        arrow from 
“A” to “B”



Create following biochemical reaction
Click [Simulation] → [ControlPanel] 
and call SBML ODE Solver

Simulation (ex1)

k = 0.3
A = 0.1
B = 0

v = k[A]



Right click on the reaction and select 
[Edit KineticLaw...]

Simulation (ex1)



Simulation (ex1)
Click [New] button on [Parameters] tab

Input values as follows:
id: k
name: k
value: 0.3

k = 0.3
A = 0.1
B = 0

v = k[A]



v = k[A]

Simulation (ex1)

Click top most text field
Type k * (k times)
Select Protein “A”
Click [Name] checkbox
( k*s1 → k*A )

k = 0.3
A = 0.1
B = 0





Simulation (ex1)
Double click [initialQuantity] column for 
Protein “A”

Set value as 0.1
k = 0.3
A = 0.1
B = 0

v = k[A]



Simulation (ex1)
Click [Simulation] → [ControlPanel]
Set [End Time] to 20
Click [Execute] button



Rename Species ID (s1 → A)
Click [Edit]  → [Replace Species ID]
Click [Copy ‘Name’ into ...] button
Use “Species Name” in KineticLaw Editor



Network → Equation

d[B]
dt

= k[A]

d[A]
dt

= �k[A]

A CB

v1 = k[A] v2 = k[B]

d[C]
dt

= k[B]

�k[B]



Equation → Network

dA

dt
= �k1A

dB

dt
= �k2B

dC

dt
= k1A + k2B � k3C

dD

dt
= k3C

A

B

C

D



Simulation (ex2)
Change parameter k1 to 30.0

A = 0.5

B = 0.2

k1 * A * B
k1 = 0.3

C = 0.01 D = 0.02

E = 0

F = 0

k2 * C k3 * D
k3 = 0.6k2 = 0.01

0 < t < 100

k1 = 30.0

k1 = 0.3 k1 = 30.0



Simulation (ex2)
Click [Parameters] tab
Double click [Value] column for k1
Change parameter k1 to 30.0



Simulation (ex2)
Click [Interactive Simulation] tab
Click [Parameter value] radio button
Click [Define Range] button
Click [Max] column for k1 and set value as 3.0

Drag sliderbar for k1



Circadian clock model

•Protein (P) inhibits transcription of mRNA (M)

•M is translated to Protein (R)

•P / R will be transported to cytosol / nucleus

J. theor. Biol. (2002) 216, 
193–208

dM

dt
=

1
1 + (P/h)n

� aM � sM

dR

dt
= sM � (d + u)R + vP

dP

dt
= uR� vP



Circadian clock model



Circadian clock model

0.1

0.5 0.5

0.5

a = s = d = v = 1.0
u = 0.1
h = 0.01
n = 40

dM

dt
=

1
1 + (P/h)n

� aM � sM

dR

dt
= sM � (d + u)R + vP

dP

dt
= uR� vP

xn = pow(x, n)

End  Time: 50
Num. of Points: 1,000



Circadian clock model

0.1

0.5

0.5

0.5

1 / (1+ pow(P/h, n))

uR dR

vP

sM

aM

a = s = d = v = 1.0
u = 0.1
h = 0.01
n = 40

dM

dt
=

1
1 + (P/h)n

� aM � sM

dR

dt
= sM � (d + u)R + vP

dP

dt
= uR� vP End  Time: 50

Num. of Points: 1,000



Boundary condition



dM

dt
=

1
1 + (P/h)n

� aM � sM

dR

dt
= sM � (d + u)R + vP

dP

dt
= uR� vP

n = 40

Oscillation
(stable limit cycle)

Qualitative change by ‘n’

End  Time: 50
Num. of Points: 1,000



dM

dt
=

1
1 + (P/h)n

� aM � sM

dR

dt
= sM � (d + u)R + vP

dP

dt
= uR� vP

n = 8

Stable fixed point

Qualitative change by ‘n’

End  Time: 50
Num. of Points: 1,000



Why we simulate a model?

n = 40 n = 8 Stable fixed pointOscillation
(stable limit cycle)

Mathematical model and 
Quantitative evaluation 
(Simulation) will reach a 
Qualitative conclusion



Import model from BioModels.net

Database connection



Database connection
Import model from BioModels.net



SABIO-RK
•Web-accessible database 

•http://sabio.h-its.org/

•Contains information about biochemical 
reactions, related kinetic equations and 
parameters



CellDesigner ⇔ SABIO RK
•Users can import additional information 

to each object (reaction) on-the-fly

•SBML (Systems Biology Markup Language) 
is used to exchange information

S P

E Name, EC number

kinetic law, parameters,
function / unit definitions

CellDesigner

Vmax[S]
Km + [S]



Integration
•Import kinetic law, parameters to 

the model from SABIO-RK



Annotating a model

Akira Funahashi & Noriko Hiroi & Yuta Tokuoka
Keio University, Japan

6th Aug. 2017



IGF signaling pathway

Peripheral insulin resistance contributes to
type 2 diabetes, but !-cell failure is the es-
sential feature of all types of diabetes. ! cells
frequently fail to compensate for insulin re-
sistance, apparently because the IRS2-branch
of the insulin and IGF signaling cascade is
also essential for !-cell growth, function, and
survival (14). Increased expression of IRS2
in ! cells promotes compensatory insulin secre-
tion in obese mice and prevents !-cell destruction
induced by streptozotocin—a drug that induces
type 1 diabetes; IRS2 also improves the survival
and function of islet transplants in mice. Drugs
that increase IRS2 synthesis might be useful treat-
ments for diabetes. For
example, expression of
the IRS2 gene in !
cells is increased by
agonists that stimulate
adenosine 3",5"-mono-
phosphate (cAMP)
production—including
glucagon-like peptide–
1 or glucose itself—
through pathways that
activate the transcrip-
tion factor CREB (15)
(Fig. 1).

Understanding dys-
regulated insulin sig-
aling is an impor-
tant goal because it
causes a cohort of
systemic disorders—
dyslipidemia, hyper-
tension, cardiovascular
disease, stroke, blind-
ness, kidney disease,
female infertility, and
neurodegeneration.
Subtle genetic poly-
morphism influenc-
es lifelong insulin
sensitivity, whereas
distinct monogenic
disorders are diffi-
cult to identify and
are usually associat-
ed with rare metabol-
ic diseases. Acute and
chronic inflammation cause insulin resistance,
which provides a framework to understand how
diet, physiological stress, and obesity promote
insulin resistance. Proinflammatory cytokines,
including IL-6 and tumor necrosis factor–#
(TNF-#) that are secreted from leukocytes dur-
ing inflammation, are also produced in adipose
tissue. TNF-# promotes serine phosphorylation
of IRS1 and IRS2, which correlates closely
with insulin resistance (16). Although TNF-#
regulates various kinases, the c-Jun N-terminal
kinase (Jnk) is a prominent effector because it
binds to IRS1 and IRS2 and phosphorylates
serine residues that inhibit insulin-stimulated
tyrosine phosphorylation (17). The knockout of

Jnk1 in obese mice, or inhibition of serine
kinases by salicylates, reduces Ser phosphor-
ylation of IRS proteins and reverses hyper-
glycemia, hyperinsulinemia, and dyslipide-
mia in obese rodents by sensitizing insulin
signaling pathways (18).

Ubiquitin-mediated degradation of IRS1
and IRS2 also promotes insulin resistance
(Fig. 1). IL-6 secreted from leukocytes and
adipocytes increases expression of SOCS
proteins, which are best known for their abil-
ity to inhibit cytokine receptor signaling.
However, SOCS1 and SOCS3 also recruit an
elongin BC-based ubiquitin ligase into the

IRS-protein complexes to mediate ubiquiti-
nylation (19). Ubiquitin-mediated degrada-
tion of IRS1 and IRS2 might be a general
mechanism of cytokine-induced insulin resis-
tance that contributes to diabetes and !-cell
failure. Modern genomic approaches have re-
vealed new cytokines secreted from adipo-
cytes that directly influence nutrient ho-
meostasis and insulin sensitivity, including
leptin, resistin, and adiponectin. How adi-
ponectin signaling stimulates insulin signal-
ing deserves attention (20).

Protein or lipid phosphatases, including
PTP1B, SHIP2, or PTEN, inhibit insulin sig-
naling (Fig. 1). Disruption of each gene in

mice increases insulin sensitivity, revealing
targets for inhibitor design. However, inhibi-
tion of SHIP2 or pTEN might be risky be-
cause they stabilize PI(3,4,5)P3, which can
stimulate cell growth. By contrast, PTP1B
resides in the endoplasmic reticulum, where it
dephosphorylates the insulin receptor during inter-
nalization and recycling to the plasma membrane
(21). This specialized mechanism appears to limit
dangerous side effects of PTP1B inhibitors.

The close association between obesity and
insulin resistance, and their progression to type
2 diabetes, is a serious health problem. Whether
better management of chronic inflammation can

improve insulin action,
promote !-cell func-
tion, and restore central
nervous system appe-
tite control is an impor-
tant area of investiga-
tion. Finding drugs that
stimulate IRS2 synthe-
sis or promote its sig-
naling might be a good
starting point. Howev-
er, too much insulin ac-
tion might be detrimen-
tal, so future work must
better resolve the net-
work of insulin re-
sponses that are gener-
ated in various tissues,
and attempt to distin-
guish the ones that
prolong health from
the ones that might
diminish it.
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Fig. 1. Regulation of insulin and IGF signaling. Insulin and IGF1 receptors form hybrids that
modulate the selectivity and affinity for insulin and insulin-like growth factors (IGF1 and IGF2).
Insulin or IGF binding stimulates tyrosine autophosphorylation in the receptor ! subunits, which
activates the kinase and recruits cellular substrates—IRS1 and IRS2—for tyrosine phosphorylation.
Recruitment is regulated by serine phosphorylation of the IRS proteins, which inhibits the
interaction between its PTB domain and the phosphorylated receptor. Proinflammatory cytokines
increase the synthesis of SOCS1 or SOCS3, which promote ubiquitination and degradation of IRS1
and IRS2. Production of cAMP enhances expression of IRS2 through the activity of phosphorylated
CREB. Tyrosine phosphorylation of IRS1 or IRS2 recruits and activates various SH2 domain–
containing proteins, including the PI 3-kinase, which activates the PKB cascade. Abbreviations: pY,
phosphotyrosine; pS, phosphoserine; PKC$/%, protein kinase C $ or %; E2, ubiquitin conjugating
enzymes; TNF#R, tumor necrosis factor–# receptor; GLP-1R, glucagon-like peptide–1 receptor;
IL6R, interleukin-6 receptor; for other abbreviations, see the text.
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Insulin Signaling in Health and Disease
Science 302 (5651), 2003, 1710.
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Figure 2. Insulin, IGF-I and IGF-II binding to IR and IGF-IR. Ligand binding triggers receptor autophosphorylation and RTK activation, permitting IRS-1, IRS-2 or Shc
phosphorylation. Mitogenic signaling pursues via Grb2 activation of the GEF (guanine nucleotide exchange factor) SoS, enabling Ras/Rheb activation. Activated Ras/Rheb
initiates the MAPK/ERK pathway through Raf-1 phosphorylation and enhances mTOR/raptor signaling, collectively increasing cell growth, proliferation, protein expression
and viability. Induction of the PI3K pathway enhances metabolic insulin effects and mitigates pro-apoptotic and anti-mitogenic signaling. Hsp90 client proteins are indicated
with a pink bar and serve crucial roles in regulating insulin/IGF signaling. Potential modulation effects of insulin/IGF signaling components upon Hsp expression and
function are shown in the black box. Abbreviations: BAD, Bcl-2-associated death promoter; BAX, Bcl-2-associated X; 4EBP1, eIF4E binding protein-1; CREB, cAMP-response
element binding; eIF2, eukaryotic initiation factor 2; eIF4E, eukaryotic translation initiation factor-4E; ERK-1/2, extracellular-signal-regulated kinase-1/2; FoxO3a, forkhead
box ‘other’ 3a; GLUT4, glucose transporter 4; Grb2, growth factor receptor-bound protein 2; GSK-3b, glycogen synthase kinase-3b; HSF1, heat shock factor-1; Hsp, heat
shock protein; HSR, heat shock response; IGF-IR, insulin-like growth factor-I receptor; IR, insulin receptor; IRS-1/2, insulin receptor substrate-1/2; MAPK, mitogen-activated
protein kinase; MEK1, MAPK/ERK kinase 1; Met-tRNAi

Met, initiator methionyl-tRNA; mTOR, mammalian target of rapamycin; raptor, regulatory-associated protein of mTOR;
MDM2, murine double minute-2; PDK1, phosphoinositide-dependent kinase-1; PI3K, phosphatidylinositol 3-kinase; PIP2, phosphatidylinositol 4,5-bisphosphate; PIP3,
phosphatidylinositol 3,4,5-triphosphate; PKC, protein kinase C; PTEN, phosphatase and tensin homolog; RTK, receptor tyrosine kinase; Shc, Src homology 2 domain-
containing; SoS, son of sevenless; TSC, tuberous sclerosis complex.

Review Trends in Pharmacological Sciences March 2012, Vol. 33, No. 3

133

Heat shock response and insulin-
associated neurodegeneration
Trends in Pharmacological Sciences, 
33(3), 2012, 129–137



http://www.sbgn.org/
Documents/PD_L1_Examples

IGF signaling pathway



Exercise
Create a following model on CellDesigner

http://www.sbgn.org/Documents/PD_L1_Examples



Exercise
Search Database from CellDesigner

http://www.sbgn.org/Documents/PD_L1_Examples



Database Connection
Search Database by Notes:

PubMed:  PMID: 123456
Entrez Gene: GeneID: 4015



Database Connection
Search Database by Notes:

PubMed:  PMID: 123456
Entrez Gene: GeneID: 4015



Exercise
Add UniProt ID for Proteins, PubMed ID for 
reactions and  call “Connect to UniProt”

UniProt: P08069

PMID: 14657487
PMID: 22172248

UniProt: P05019



MIRIAM annotation

NATURE BIOTECHNOLOGY  VOLUME 23   NUMBER 12   DECEMBER 2005 1509

Minimum information requested in the annotation of 
biochemical models (MIRIAM)
Nicolas Le Novère1,15, Andrew Finney2,15, Michael Hucka3, Upinder S Bhalla4, Fabien Campagne5,
Julio Collado-Vides6, Edmund J Crampin7, Matt Halstead7, Edda Klipp8, Pedro Mendes9, Poul Nielsen7,
Herbert Sauro10, Bruce Shapiro11, Jacky L Snoep12, Hugh D Spence13 & Barry L Wanner14

Most of the published quantitative models in biology are 
lost for the community because they are either not made 
available or they are insufficiently characterized to allow 
them to be reused. The lack of a standard description format, 
lack of stringent reviewing and authors’ carelessness are 
the main causes for incomplete model descriptions. With 
today’s increased interest in detailed biochemical models, 
it is necessary to define a minimum quality standard for 
the encoding of those models. We propose a set of rules for 
curating quantitative models of biological systems. These 
rules define procedures for encoding and annotating models 
represented in machine-readable form. We believe their 
application will enable users to (i) have confidence that 
curated models are an accurate reflection of their associated 
reference descriptions, (ii) search collections of curated 
models with precision, (iii) quickly identify the biological 
phenomena that a given curated model or model constituent 
represents and (iv) facilitate model reuse and composition 
into large subcellular models.

During the genomic era we have witnessed a vast increase in availabil-
ity of large amounts of quantitative data. This is motivating a shift in 
the focus of molecular and cellular research from qualitative descrip-
tions of biochemical interactions towards the quantification of such 
interactions and their dynamics. One of the tenets of systems biology 
is the use of quantitative models (see Box 1 for definitions) as a mech-
anism for capturing precise hypotheses and making predictions1,2. 
Many specialized models exist that attempt to explain aspects of the 
cellular machinery. However, as has happened with other types of bio-
logical information, such as sequences, macromolecular structures or

1European Bioinformatics Institute, Hinxton, CB10 1SD, UK. 
2Physiomics PLC, Magdalen Centre, Oxford Science Park, Oxford, 
OX4 4GA,K. 3Control and Dynamical Systems, California Institute of 
Technology,Pasadena, California 91125, USA. 4National Centre for Biological 
Sciences, TIFR, UAS-GKVK Campus, Bangalore 560065, India. 5Institute 
for Computational Biomedicine, Weill Medical College of Cornell University, 
New York, New York 10021, USA. 6Center for Genomic Sciences, Universidad 
Nacional Autónoma de México, Av. Universidad s/n, Cuernavaca, Morelos, 
62100, Mexico. 7Bioengineering Institute and Department of Engineering 
Science, The University of Auckland, Private Bag 92019, Auckland, New 
Zealand. 8Max-Planck Institute for Molecular Genetics, Berlin Center for 
Genome based Bioinformatics (BCB), Ihnestr. 73, 14195 Berlin, Germany. 
9Virginia Bioinformatics Institute, Virginia Tech, Washington St., Blacksburg, 
Virginia 24061-0477, USA. 10Keck Graduate Institute, 535 Watson Drive, 
Claremont, California 91711, USA. 11Jet Propulsion Laboratory, California 
Institute of Technology, Pasadena, California 91109, USA. 12Triple-J Group 
for Molecular Cell Physiology, Department of Biochemistry, Stellenbosch 
University, Private Bag X1, Matieland 7602, South Africa. 13Department of 
Scientific Computing & Mathematical Modeling, GlaxoSmithKline Research 
& Development Limited, Medicines Research Centre, Gummels Wood 
Road, Stevenage, Herts, SG1 2NY, UK. 14Purdue University, Department of 
Biological Sciences, Lilly Hall of Life Sciences, 915 W. State Street, West 
Lafayette, Indiana 47907-2054, USA. 15These authors have contributed 
equally to the work. Correspondence should be addressed to N.L.N.
(e-mail: lenov@ebi.ac.uk).

Published online 6 December 2005; doi:10.1038/nbt1156

Box 1  Glossary

Some terms are used in a very specific way throughout the article. 
We provide here a precise definition of each one.

Quantitative biochemical model. A formal model of a biological 
system, based on the mathematical description of its molecular 
and cellular components, and the interactions between those 
components.

Encoded model. A mathematical model written in a formal 
machine-readable language, such that it can be systematically 
parsed and employed by simulation and analysis software without 
further human translation.

MIRIAM-compliant model. A model that passes all the tests and 
fulfills all the conditions listed in MIRIAM.

Reference description. A unique document that describes, or 
references the description of the model, the structure of the 
model, the numerical values necessary to instantiate a simulation 
from the model, or to perform a mathematical analysis of the 
model, and the results one expects from such a simulation or 
analysis.

Curation process. The process by which the compliance of an 
encoded model with MIRIAM is achieved and/or verified. The 
curation process may encompass some or all of the following 
tasks: encoding of the model, verification of the reference 
correspondence and annotation of the model.

Reference correspondence. The fact that the structure of a 
model and the results of a simulation or an analysis match the 
information present in the reference description.
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Minimum information requested in the annotation of biochemical models (MIRIAM)
Nature Biotechnology 23, 1509 - 1515 (2005)



http://www.ebi.ac.uk/miriam/main/qualifiers/

is
hasPart
isPartOf
hasVersion (isoform)
isVersionOf (superclass, parent)

MIRIAM annotation

  IGF_IGFR hasPart: IGF
  IGF_IGFR hasPart: IGFR

  IGF isPartOf: IGF_IGFR

  IGFR isPartOf: IGF_IGFR



Exercise
Add MIRIAM annotation

  hasPart: UniProt: P05019
  hasPart: UniProt: P08069

  is: ChEBI: CHEBI:15422   is: ChEBI: CHEBI:16761



CellDesigner Notes

Easy to add (text)
MIRIAM

Tool neutral (SBML)
Precise annotation

Notes or MIRIAM?



Summary
Introduction of CellDesigner

What kind of model you can build
Mathematical model
Pathway map

How to build a model with CellDesigner
From scratch
Import a model from BioModels.net
Import kinetic law and parameters from 
SABIO-RK


